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1.  Using MediaWorks Plus 

1.1.  Introduction to MediaWorks Plus 

MediaWorks Plus provides several ways to locate, organize, and replay 

recordings stored on an Eventide NexLog recorder. Once the desired recordings 

have been found, they can be easily organized into incidents for saving and 

export. The recordings can also be examined, updated and listened to. With 

MediaWorks Plus you can also live monitor channel(s), view the current status of 

channel(s), and (if permitted) enable/disable recording on channel(s) for on-

demand record/don’t record purposes. 

The data for each recording can be exported in a number of different ways. 

The information about using MediaWorks Plus includes: 

 Section 1.3. Locating and Organizing Recordings  

 Section 1.4. Viewing and Playing Recordings  

 Section 1.5. Creating an Incident 

 Section 1.6. Updating Recordings 

 Section 1.7. Exporting Recording Data from an Incident 

 Section 1.8. Monitoring a Recorder  

 Section 1.9. Geolocation Features: Geo-Display and Geo-Fence 

 Section 1.10 Search Filter Groups 

 Section 1.11 NexLog Access Bridge 

 Section 1.12 Archives 

1.2.  Opening MediaWorks Plus 

Open one of the supported browsers: 

 Internet Explorer 8 – 11 

 Firefox 
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 Chrome 

Enter the address of your NexLog recorder in the URL bar. The address will 

either be an IP address or a DNS address if configured. Loading the MediaWorks 

Plus application in the browser will bring you to a welcome page. The welcome 

page presents a link to the Eventide NexLog Configuration Manager and 

MediaWorks Plus. There is also links to documentation. Click on the 

MediaWorks Plus Icon to navigate to MediaWorks Plus.  

MediaWorks Plus will start to load, as shown in Figure 1 below. The first load 

may take several seconds to load depending on the connection speed. When 

prompted to login, enter your NexLog User Name and Password, and click OK. 

For MediaWorks Plus to connect to the recorder with HTTP, ports 80 and 81 

must be open; for HTTPS, ports 443 and 82. If you can’t connect, check with 

your network administrator that these ports are open. 

Note that it’s possible to configure your NexLog recorders landing page to be 

MediaWorks Plus, under the Users and Security: System Security page of 

Configuration Manager. 

Figure 1. MediaWorks Plus loading and login screen 
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1.3.  Locating and Organizing Recordings 

The typical process for finding and organizing recordings includes the following 

steps: 

 Browse or search for recording data on the recorder. 

 Create and save Incidents by selecting individual recordings or groups of 

recordings and organizing them into incidents. 

 Export the data in a variety of formats. 

1.3.1.  Browsing for Recordings 

The simplest method for locating recordings on the recorder is provided by the 

Browse tab, Figure 2. When viewing the Browse tab, the connected source 

appears in the left. Below the source, a list of months corresponding to the 

available data on the recorder will appear after you click on the + sign next to 

the source. Clicking on a + sign next to a month will display all of the days in 

that month that data was recorded. Clicking on a + sign next to a day will open 

a list of channels on that recorder that contain the data for the day selected. 

When you click on a channel, MediaWorks Plus retrieves the recordings for that 

channel and displays them in the upper right pane. 

Figure 2. Browse Tab 
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To retrieve recordings for a different day, expand the tree for the appropriate day 

and click on the desired channel. The recordings for that channel will then be 

retrieved and displayed. 

The Browse tab can display the list of channel in three modes: Resource Name, 

Resource Name Grouped by Recorder, or Channel Number Grouped by 

Recorder. The default is Resource Name. To change the display mode, click on 

Show… at the top of the left pane and select the mode from the drop-down 

menu. When viewing the information by Channel Number Grouped by 

Recorder, each physical channel on the primary recorder and connected bridges 

and archives will be listed with its channel number. When viewing by Resource 

Name, each channel on the recorder and on all connected NexLog Access 

Bridges will be listed by its resource name. 

When using the Grouped by Recorder options, the resources will be divided into 

groups by which NexLog system the resources originate from. In Resource Name 

mode, all resources made available by NexLog Access Bridge connections will be 

listed alongside the locally available resources as if they were all one system. 

Because physical Channel Number is tied specifically to hardware, it is only 

available in Grouped by Recorder format. 

1.3.2.  Searching for Recordings 

MediaWorks Plus provides a powerful interface for advanced recording retrieval 

in the Search tab. When viewing the Search tab, a list of search criteria in the 

form of Filters is provided in the left pane. Clicking on Filters… at the top of the 

pane displays a drop-down list of filters. 

Figure 3. Search Tab 
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Each element of a search is contained within a search “panel” in the left pane of 

the Search tab. The Date and Channel panels are always required, so you must 

provide, at a minimum, a value for these criteria to conduct a search for 

recordings. When more filters are added, additional panels will appear as 

needed. If necessary, scroll the search panel to view the additional panels. Each 

filter panel can be compressed or expanded by clicking on the arrow located in 

the upper left corner of the pane. 

Creating a Search 

To create a search, first select one or more days from the Date filter area. Dates 

can be selected by clicking on the calendar (default), or by specifying a date 

range or relative time period. To change the way a date filter is specified, click 

the down arrow in the upper right corner of the Date filter panel and choose the 

desired mode from the drop-down menu. The modes include Calendar (default), 

Date Range, and Relative.  

In the Calendar mode, you can select recordings across more than one month, 

as follows:  After selecting one or more days in one month in the calendar, click 

the forward or backward arrow to navigate to a different month. While holding 

the Ctrl key down, select additional days in the second month.  

In the Calendar mode, you can also select a continuous range of dates across 

more than one month, as follows:  Select the earliest date, click the forward 

arrow to navigate to the next month, hold down the Shift key, and select the last 

date. 

Next, one or more resources or resource groups can be included in the search by 

selecting them in the Resources filter panel below the Date panel. The Resources 

filter displays resources for the recorder. Any number of resources can be 

selected. Resources can be selected by Resource Name, physical Channel 

Number Grouped by Recorder, or by Resource Name Grouped by Recorder. To 

change the way the Resources filter is displayed, click the down arrow in the 

upper right corner of the Resources filter panel and choose the desired mode 

from the drop-down menu. 

When using the Grouped by Recorder options, the resources will be separated by 

NexLog system the resources originate from. In Resource Name mode, all 

resources made available by NexLog Access Bridge connections will be listed 

alongside the locally available resources as if it were all one system. Because 

physical Channel Number is tied specifically to hardware, it is only available in 

Grouped by Recorder format. 

Initiating a Search 

To initiate a search, click on the Search button at the top right in the Search 

pane. All recordings that meet the search criteria will be displayed in the tabular 

record view (in the right pane). You can also press the enter key to kick off a 
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search after changing any of the search parameters; otherwise the enter key will 

start playback on the currently selected call. 

1.3.3.  Using Additional Filters 

You may narrow your search by specifying additional filters, such as Call 

Length or Protected. To add an additional Search filter, click on Filters… and 

select a filter from the drop-down list. The selected filter will be displayed below 

the Channel filter area. More filters can be added, if necessary. Each new filter 

will appear as an additional panel. 

 Note: Some additional filters are standard on all recorders and will always appear on 

the drop-down list. Other additional filters depend on the custom fields included 

in the recording table. Some or none of these filters may be included on the 

drop-down list of your recorder. 

To remove a filter, click the X button which appears in the title bar of each 

optional filter. Alternately, deselect the filter from the Filters… drop-down list. 

Once removed, the filter will not be used in subsequent searches. 

Standard Additional Filters 

The following standard additional filters appear in the Filter drop-down list of all 

recorders. 

Call Length 

Enter the minimum and maximum call durations. MediaWorks Plus will search 

for all recordings equal to or between these values. 

Call Note 

Enter text in the Note box. MediaWorks Plus will perform a search for all 

recordings that contain this text string in the Notes field. Check the Case 

sensitive? box if you wish to make the search match case as well. 

PIN 

For installations that use a PIN code, enter the PIN number. MediaWorks Plus 

will include this as part of the search criteria. 

Protected 

Search for all recordings that are protected, or all recordings that are 

unprotected. 

Telephone 

Enter the telephone number digits. Check the Search DTMF box to find 

recordings which match the telephone number in the DTMF field. Check the 

Search Caller ID box to find recordings which match the telephone number in 

the Caller ID field. 
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Call Direction 

This filter only applies to recordings that contain data in the Caller ID or DTMF 

fields. Enable Incoming to find recordings that match incoming calls. Enable 

Outgoing to find recordings that match outgoing calls. Enable Unknown to 

match recordings that could not be identified as either incoming or outgoing. 

Enable Use DTMF and Caller ID to determine to use heuristics on the data in 

the Caller ID and DTMF fields to determine call direction. 

Suppressed 

Check Show suppressed to search for recordings that were suppressed on the 

recorder. Check Show unsuppressed to search for recordings that were 

unsuppressed on the recorder. Check Show forced to search for recordings that 

were forced into recording on the recorder. 

Audited 

Check Show accessed to search for recordings have had their data accessed by 

client applications. Check Show not accessed to search for recordings that have 

not had their data accessed by client applications. 

Deleted 

Click on Show deleted to search for recordings that do not have audio data 

associated with them (as may happen when the recorder purges data 

periodically to maintain free-space for newer calls. Click on Show not deleted to 

search for recordings that do have audio data associated with them. 

Custom Additional Filters 

These additional filters are based on the custom fields that have been added to 

the call properties for a particular recorder. Enter the string as it appears in the 

More tab of the Call Properties screen. 

Following are some typical examples of additional custom filters which may or 

may not appear in the Filter drop-down list of your recorder, depending on your 

particular custom fields. 

City 

Search for recordings that have a specific city name associated with them. Enter 

the city name string the Search for: box. 

Customer Name 

Search for recordings that have a specific customer name associated with them. 

Enter the customer name string in the Search for: box. 

Geo-Fence 

Search on a map for data occurring inside one or more geometric shapes. This 

feature must be enabled on the recorder and location data must be provided. 
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See additional information in Section 1.9: Geolocation Features: Geo-Display 

and Geo-Fence. 

Radioid 

Search for radio call recordings that have Radioid information associated with 

them. Enter the Radioid string in the Search for: box. 

State 

Search for recordings that have a specific state associated with them. Enter the 

state string in the Search for: box. 

Street Address 

Search for recordings that have a specific street address associated with them. 

Enter the street address string in the Search for: box. 

Subject 

Search for recordings that have a specific subject associated with them. Enter 

the subject string in the Search for: box. 

Talkgroup 

Search for recordings that have a specific talk group associated with them. 

Enter the talk group string in the Search for: box. 

Time 

Search for recordings that have a specific time associated with them. Enter the 

time string in the Search for: box. 

User Id 

Search for recordings that have a specific user ID associated with them. Enter 

the user ID string in the Search for: box. 

1.3.4.  Saved Search Filters 

If you regularly make use of the advanced Search Filter options, you will likely 

find Saved Search Filters a very useful feature. This allows you to save and 

recall customizable search filters, including all metadata fields and search 

criteria (date, resources) in the format and style you most prefer. 

Saved Search filters can be accessed from the Filters button or the Tools Menu 

option Edit Search Filters. These options open a pop up window that allows 

you to load, save, and delete search filters. Filters are saved based on the 

current state of the search column, and you can choose which values to 

remember for the search, including Date, Resources, and any metadata options 

currently open. 

The Filter Name and lower section (by default called New Search Filter) show the 

Filter you are currently acting on. Clicking a saved search will load the details 

into this window. If you want to then load it into the search tab, click Load. 
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If you click one of the saved search filters and then want to work with the 

current settings instead, click View Current to load the current settings into this 

window, from which they can be edited and saved. 

For example, one may want to save a search that shows the last three days of 

call activity on a set of channels, to load each Monday to see what happened 

over the weekend. To create a filter like that, configure a search for Relative date 

mode, set it to 3 days, then select the resources desired, and then open the Edit 

Search Filters and save as Last 3 Days. 

Figure 4. Last 3 Days Example 

 

Saved Search Filters work well with Geo-Location; you can save Geo-Fences of 

areas you regularly search and recall them with ease. 
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Figure 5. Export Incident 

 

1.3.5.  Tab Search 

Tab Search allows you to narrow your search results by searching all fields of 

all calls in a given search result for any text string. For example, searching on 

“212” could return calls that have 212 in DTMF, Caller ID or a Street Address. It 

is a simple tool to find information quickly. 

Once a search is performed, the calls will be listed only by the field that matched 

and the contents of that field; clicking on a row in Tab Search will highlight that 

call in the call grid. 

Tab Search is accessible from the View menu (Show Tab Search), and once 

shown, from the tool bar above the call grid via the Magnifying Glass icon. 

1.4.  Viewing and Playing Recordings 

After you have found and organized recordings you may view and play the 

recordings. 

1.4.1.  Viewing Recordings 

Recordings displayed in the Browse, Search, or Incident tabs are shown in two 

different ways simultaneously. The first is a simple tabular list displayed in the 

upper right-hand pane, called the record view. This view can be customized in 

that it supports a number of different column and sorting options. The second is 
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a graphical chart of recordings displayed in the lower right-hand pane referred 

to as the timeline. The timeline can also be customized, but only supports a 

single method of displaying the recording data by time. 

Together, the record view and timeline view provide a comprehensive look into 

the same set of data. Selections between the two views are synchronized; any 

recordings selected in one are automatically selected in the other. Similar 

operations may be performed from each view, including playback and export. 

1.4.2.  The Record View 

The record view in the upper right-hand pane presents recording data in tabular 

format. You may sort the information by clicking on the appropriate column 

heading. A small arrow will indicate the sort direction. To reverse the sort, click 

the column heading again. Columns can also be reorganized. Click and drag any 

column heading to a new position. The type and number of columns can also be 

customized. Right click any column heading and a menu of available column 

names will appear. You may add or delete a column from this menu. 

To reset the columns to their user-defined default values, select the Reset to 

Default option. 

Figure 6. Record View 

 

1.4.3.  Record View Menu Options 

Selecting a recording in the Record view and then right-clicking on that 

recording causes the Record View menu to appear. 
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Figure 7. Record View Menu 

 

 

The Record View menu selections include: 

 Properties – See Section 1.6.1.  Call Properties Screen 

 Protect – Checking this box prevents the selected recording from being 

deleted from the recorder due to recorder call retention policy. 

 New Incident from Selected Records – See Section 1.5 Creating an 

Incident. 

 Add Selected to incident – See Section 1.5.1.  Adding and Removing 

Recordings from an Incident. 

 Evaluate Records – Evaluate selected call recordings. Requires Quality 

Factor add-on license. See Eventide Quality Factor Software Manual for 

details. 

 Start Sequential Playback – See Sequential Playback Mode. 

 Export… – See Section 1.7.  Exporting Recording Data from an Incident. 

 Export Single Recording – See Section 1.7.  Exporting Recording Data from 

an Incident. 

 Add Text Annotation – Add notes to a call, at a specific point in time. See 

Section 1.6.2 Annotating Calls. 

 Add Audio Annotation – Add audio commentary to a call, at a specific point 

in time. See Section 1.6.2 Annotating Calls. 

 Draw Waveform – Generate a waveform for the recording if it’s an audio call. 

The waveform is displayed in the Timeline View. 
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 Generate Word Factor – Generate a searchable “best guess” at what the 

audio contains as text. Requires a Word Factor add-on license and patch. 

1.4.4.  The Timeline View 

The Timeline view in the lower right-hand pane, Figure 6, shows the same set of 

recordings that are displayed in the Record view, but presents the recording 

data in a linear chart. Recordings are organized into groups by channel name 

and are displayed in chronological order from left to right. The individual 

recordings are drawn in the timeline in the horizontal direction in relation to 

their duration. Scroll the timeline to the right (or to the left) to view recordings 

that are not visible. If more than one channel is represented in the data, scroll 

the timeline up or down to display channels that may not be initially visible. 

Figure 8. Timeline View-Audio Recording 

 

You can increase or decrease the time length displayed on the timeline. To view 

more or fewer recordings, click on the small green magnifying glass in the lower 

left corner of the pane. In the Figure above, it has the words One Minute next to 

it. Clicking this will open a menu offering a variety of time scales from ten 

seconds to 1 year. The selected time scale defines the amount of time to be 

displayed between each “tick” on the timeline. In the Figure above, there are 

three ticks, each representing the start of a minute. 

Playback Settings 

In the Channel Name box on the left there are a number of playback settings 

that you can set on a channel-by-channel basis. They include: 

 

Mute button - Clicking on the mute button (green speaker icon) to the left of the 

down arrow mutes the sound on the selected channel. The button will then be 
grayed out. Clicking on the grayed-out mute button will restore the sound to that 
channel. 

Clicking on the down arrow displays a menu with the following selections: 

 Options… - Clicking on this menu item displays an Options dialog box. (See 

Playback Settings Options below.) 

 AGC – Checking this box will enable automatic gain control on this channel. 
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Moving the volume slider left or right decreases or increases the volume for this 
channel. 

 

Moving the balance slider to the left increases the volume on the left channel and 
decreases the volume on the right channel. Moving the slider to the right 
increases the sound on the right channel and decreases the sound on the left 
channel. These per-channel sliders allow you to present one or more channels on 
the left and other channel(s) on the right of a set of stereo speakers (or 
headphones). 

Playback Settings Options 

The Options dialog box for playback settings allows you to mute the sound on 

this channel by checking the Enabled box associated with the Mute option. 

 

You can also set the amount of playback automatic gain control for this channel 

by first selecting the AGC option and then checking the Enabled box and 

selecting a value in the Max gain: window. You can choose a relative value from 

1 to 100. The default value is 15. 
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The obfuscate option allows you to garble the sound of voices on the channel so 

that the identity of the speaker is obscured. The Amount slider allows you to 

adjust the amount the effect is applied to the audio. 

Resource Gain Defaults 

Figure 9. Resource Gain Defaults 
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In the Tools menu, you will find Resource Gain Defaults, which opens to the 

above panel that allows you to configure a default setting for the AGC and Gain 

for every resource name currently on the system, so that every tab you open 

from then on will load these settings. 

Reset will return to factory defaults: AGC Off, Volume at 0db gain. Use Current 

will change the settings to those set in the currently open tab; this is useful if 

you’ve gotten it “just right” and want to save the settings for the future. Apply To 

Tab will apply all of the settings in this pop up to the open tab. Save will save 

the settings and they will be applied when new tabs are opened. 

Timeline View Menu Options 

Selecting a recording in the Timeline view and then right-clicking on that 

recording causes the Timeline View menu to appear, Figure 7. 

The menu selections are the same as those in the Record View menu. Refer to 

the Record View Menu Options for information about those menu items. 

Figure 10. Timeline View Menu 

 

 Note: When working in an Incident Tab, there is also a Remove option that can be 

selected; selecting Remove From Incident allows you to remove the selected 

recording(s) from the incident. 

Timeline Zoom Options 

The Timeline has zoom options that let you adjust how much call data you are 

looking at in a given amount of horizontal space. This ranges in granularity from 

one second to one year.  
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Figure 11. Timeline View-Audio Recording 

 

The Timeline has zoom options that let you adjust how much call data you are 

looking at in a given amount of horizontal space. This ranges in granularity from 

one second to one year. This grain affects what the distance between two 

markers on the timeline means. In the example below, the zoom is set to one 

minute and the dark checkmarks in the timeline are one minute apart: 

Figure 12. Timeline at One Minute Zoom Level 

 

 

Draw Waveform 

Waveforms show you a visualization of an audio call, giving a rough 

representation of the volume in the file at each point. Waveforms are most useful 

in Incidents, where calls can be redacted, and in an incident, waveforms are 

automatically drawn. However, you can request a waveform for any audio call in 

any timeline. 
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From the Timeline View context menu, there is an option to Draw Waveform. 

Selecting this will draw the waveform and the call record will update in the 

Timeline to show it: 

Figure 13. Call in Timeline with Manually Requested Waveform. 

 

 

1.4.5.  Playing Audio Recordings 

Once you have located recordings from the Browse, Search, or Incident tabs, you 

have a number of options for playing the recordings. The following information 

describes the options for playing recordings in the Sequential mode. In this 

mode, recordings are played one recording at a time, in the order in which they 

appear in the record list. To change the play order, sort the list of recordings 

differently. Playback will adapt to the new sequence. For information about 

playing recordings in the Mixed mode, see Section 1.4.8.  Playback Modes. 

To begin playing the audio from a recording, press the Play button in the 

Playback console at the bottom of the screen (see Section 1.4.7.  The Playback 

Console). The first recording in the list will begin playing. To indicate which 

recording is currently playing a green arrow appears to the left of the recording 

in the Recording pane. 

Alternatively, select a recording and press Enter on the keyboard to begin 

playback, or press the Spacebar on the keyboard to begin, pause, and resume 

playback. Once the first recording in the list has been selected, the Spacebar 

can only be used to pause and resume play. To select another recording, 

highlight the recording in the Record view or in the Timeline view and press the 

Enter key or double-click on the new recording. The recording will start playing 

immediately. Use the Spacebar or Pause button to stop playback and the 

Spacebar or Play button to resume playback. 

You may also use the sub-menu items in the Playback menu to control playback 

or right-click the desired recording and select Start Sequential Playback from 

the drop-down menu. 
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1.4.6.  Playing Screen Recordings 

Figure 14. Screen Playback 

 

Screen recordings can be played back in the same way as Audio calls, but there 

are additional options that relate specifically to screens. These options are 

configured via the Multimedia Display Options window you can access via the 

View menu: 

Figure 15. Multimedia Display Options 

 

This allows you configure how multimedia recordings will be played back, and 

also allows for configuring the real-time display of Metadata, discussed below. 

Display in Application is shown above in Figure 9; the screen recording plays 
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back in a floating window inside the MediaWorks Plus browser window. Display 

in Canvas looks like this: 

Figure 16. Canvas at Top 

 

A panel appears above or to the right of the search results (depending on the 

Multimedia Orientation setting). This panel is called the Multimedia Canvas. It 

can also appear to the right of the call list: 

Figure 17. Canvas to the Right 
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Figure 18. Media Window Controls (Detail) 

 

The top right corner of the media window contains these three buttons: Pop out 

to Application, Pop Out to External Window, and Close. If popped out to the 

application level, the first button will show a minus sign for “Collapse into 

Multimedia Canvas.” 

Figure 19. Media Window Popped Out 

 

When popped out to an external window, the multimedia record is still 

controlled by the Playback Console in the main MediaWorks Plus window. It also 

just has an X for Close in the upper right corner, which will pop the call back 

into the main window. 
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Figure 20. Real-Time Metadata Panel 

 

The Metadata Panel shows a list in chronological order of the metadata 

associated with calls played back from this search, browse or incident. The line 

in bold is the current or most recently played call. This lets you highlight the 

specific metadata you want to keep track of as you play calls. 

1.4.7.  The Playback Console 

The Playback Console, located at the bottom of the browser window (Figure 16), 

allows you to control all aspects of playing recordings. From the Playback 

Console you can adjust the volume and speed of the recording(s) being played: 

 Volume – Use this slider to increase or decrease the master audio volume. 

Moving the slider to the right increases the volume; moving it to the left 

decreases the volume. Pressing the R button to the right of the slider will 

reset the slider to the default center position. 

 Speed – Use this slider to increase or decrease the playing speed of the 

recording(s). Moving the slider to the right increases the speed; moving it to 

the left decreases the speed. Pressing the R button to the right of the slider 

will reset the slider to the default position of “100%.” 

Figure 21. Playback Console 

 

The buttons in the center of the console include (from left to right): 

 Previous Recording – If playback is less than 3 seconds into the recording, 

moves to previous recording in the selected sequence. If playback is more 

than 3 seconds into the recording, resets to the start of the current 

recording. 

 Play – Plays any highlighted recording, or resumes playback after pausing. 

 Pause – Pauses playback. 

 Next Recording – Moves to the next recording in the selected sequence. 
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 Loop – Loops playback for the selected recording or recordings. For 

sequential playback, this is the beginning and end of a recording or the loop 

boundary settings within a single recording. For mixed playback this is the 

loop boundary settings anywhere within the timeline. 

To the right of the console are the following additional tools: 

 Slider – The slider on the right side of the console allows you to change the 

playback position. This is known as scrubbing. You can scrub at any time 

during playback. To quickly move to a different spot within a recording, click 

and drag the scrub slider. While scrubbing, keep track of the position by 

watching the playback time indicator. 

 Skip -  The double-arrow buttons on each side of the slider allow you to Skip 

Forward (>>) or Skip Back (<<). 

While a recording is being played, its attributes scroll from right to left in the 

area above the playback controls. This information includes recording time, 

length of the recording, the recorder from which the recording was retrieved, and 

the recording’s channel number. 

1.4.8.  Playback Modes 

MediaWorks Plus supports two modes of playback: sequential and mixed. 

Recording data can be streamed from an Eventide recorder or from a remote 

incident containing embedded audio data. Optionally, playback can be modified 

to include “talking time” information at the start of each recording. 

Sequential Playback Mode 

Sequential playback occurs on one recording at a time. The order in which 

recordings play is determined by the record view. To change the order in which 

sequential playback operates, change the sort order of the record view. 

To begin sequential playback, select Start Sequential Playback from the right-

click context menu in the Record view or Timeline view. Alternatively, you can 

double-click a recording or highlight a recording and press the Enter key. 

Mixed Playback Mode 

Mixed playback will play back recordings in the timing that they actually 

occurred. Mixed Mode playback is also referred to as ‘real time playback’. The 

order in which recordings plays is determined by the start time of the recording. 

Mixed playback always proceeds in time order, from earliest to latest. If you are 

examining recordings from multiple channels, the case may be that multiple 

recordings occur at the same or overlapping times. 

For example, if audio was recorded on a channel named “Dispatch 1” at the 

same time audio was recorded on a channel named “Emergency 5”, the audio for 
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both recordings will be played back at the same time. When audio is playing in 

Mixed mode, you can easily follow the progress in the timeline, which highlights 

all playing recordings across all channels. 

Mixed Playback of a Single Resource/Channel 

Single timeline resource/channel can be played back in mixed mode. This is 

useful for playing back a single talkgroup or resource while looking at search 

results or instant recall on more than one timeline resource at a time. In order 

to active Single Resource mixed playback hold down the Ctrl key while viewing 

the properties menu and select “Select Resource Mixed Playback.” 

Mixed Playback of Currently Selected Call Records Only. 

You can playback only a selected subset of calls in the timeline, in mixed mode. 

Use Ctrl+click to select multiple calls from the timeline or the call list, and then 

right click one of the selected calls and choose “Start Mixed Playback.” This will 

then play in real time all of the selected calls and no other calls. 

Quick Playback from Timeline Header: Click to Play. 

You can click in the timeline header (where the time is displayed along the top) 

to start mixed playback at any point. We call this “click to play.” If you have 

started calls in sequential mode, a click to play will follow suit and play in 

sequential mode. You can switch it back to Mixed by right-clicking in the 

Timeline header and selecting “Start Mixed Playback.” 

1.5.  Creating an Incident 

In MediaWorks Plus, an incident contains a group of related recordings. To find 

recordings, see Section 1.3.1.  Browsing for Recordings and Section 

1.3.2.  Searching for Recordings. Once a set of recordings has been found, the 

next step is to group them into related sets known as “incidents.” New incidents 

can be created from a selection of recordings, and additional recordings can be 

appended to existing incidents. Incidents form the foundation for many of the 

other MediaWorks Plus functions, such as exporting recording data. Incidents 

can also be shared with other users by emailing them or saving them to a 

shared location on the Eventide recorder. 

Incidents can be stored remotely on the recorder. To create a new incident, 

select New Tab from the File menu and then select Incident from the drop-

down list. An empty Incident tab labeled “Untitled” will be created. To create a 

new incident with an initial set of recordings, first select the recordings from the 

Record view or Timeline view. Then right-click and select New Incident from 
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Selected Records from the drop-down menu. A new incident tab labeled 

“Untitled” will be created containing the recordings you selected. 

Figure 22. Incident Tab 

 

An incident can also be populated with recordings in several other ways. From 

the Browse or Search tab, a group of recordings can be copied to an incident tab 

using drag-and-drop. With the Browse or Search tab open, select one or more 

recordings. Then click the selected recordings and, while holding the mouse 

button down, drag the recordings to the new Incident tab. Release the mouse 

over the Incident tab and the recordings will be added to that incident. 

1.5.1.  Adding and Removing Recordings from an Incident 

Once created, an incident can be further expanded or reduced. To add 

recordings to an open incident, first select the desired recordings from the 

Browse or Search tabs, or another Incident tab. Once selected, click and drag 

the selection to the destination Incident tab and then release it. The recordings 

will be appended to that incident. 

Alternatively, after having selected the recordings you wish to add, right-click 

the selection and choose Add to incident from the menu that appears. A 

submenu lists all possible destination incidents. Select the desired incident and 

the recordings will be appended to it. 

To remove recordings from an incident, select the recordings you wish to remove 

from the Incident tab they are associated with and select Remove from the Edit 

menu. Alternatively, you can right-click the recording selection and choose 

Remove from the menu that appears. 
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1.5.2.  Saving an Incident Remotely 

To save an incident remotely on the recorder, first make sure the Incident tab is 

selected, then select Save Incident from the File menu. If this is a new incident, 

when the Save Incident dialog box appears, the Remote tab will be automatically 

selected. 

The Protect Calls in Incident option will to automatically mark all recordings 

as protected when saving the incident; this is turned on be default. Optionally 

you can edit the incident properties and permissions here too. 

Enter an Incident Name and then click OK to save. 

1.5.3.  Saving an Incident Locally 

Incidents can be also be saved locally to your computer. By default, one usually 

wants to save an incident remotely, which means on the recorder itself, for use 

on that recorder. But if you need to share an incident across different recorders, 

you can save the incident locally to your computer as an <incident name>.eti 

file. This file can then be shared and opened with the Open Incident file menu 

option. 

To save locally, you must first save the incident remotely. Once you have saved 

it remotely, select Save Incident As from the File menu, and choose the Local 

tab. You can optionally enter a password here that the incident will require to 

open. 

Figure 23. Incident Tab 
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This file can then be shared and opened with the Open Incident file menu 

option, by clicking the local tab and clicking Add File. Select an .eti file, click ok 

and then click OK in the Open Incident dialog. If there is a password, you will be 

prompted to enter it and if that succeeds, the incident will open with all of the 

calls, notes, attachments and metadata as seen on the original recorder. 

Note that incidents can only be opened on recorders running NexLog software 

2.5 or later. 

1.5.4.  Incident Properties - Permissions 

The Properties button (at the top of the tab and in the Save window) opens to an 

Incident Properties window that allows for a searchable text description of the 

incident, as well as fine control of which permissions each user on the system 

has for this incident. 

Figure 24. Incident Properties 

 

Before NexLog 2.4, Incidents could be marked Shared, at which point every user 

on the system had read/write access. The default for new incidents is now Read 

Only: only the original creator of the incident can make changes, and everyone 

else can open it to listen to calls. 
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The radio buttons in the top line allow you to assign permissions for all users at 

once, and can also be used first to set a default state before assigning specific 

permissions to a few users. For example, you may want only two users to have 

access to this incident, so you click the All Users No Access button and then 

click Read Only for the two users you want to share it with. 

Note that the Owner of an incident always has Read/Write permissions. 

1.5.5.  Incident Properties and Notes - Description 

The Description text box at the top of the Incident Properties window can be 

used to describe the incident and highlight anything particularly interesting 

about it. This description can then be searched for in Open Incident dialog, 

making it easier to find specific incidents on systems that have many. 

1.5.6.  Incident Properties and Notes- Notes 

Figure 25. Incident Properties and Notes 

 

Notes can be added by anyone with read/write permissions for the incident. 

Each note will include the creator, the date created, and if media is attached to 

the note, a file name. Short notes will be fully visible but for longer notes, you 

can right-click and select View Note from the context menu to see the full text of 

the note.  If there is a document attached of a supported type (text, jpg, wav, 

mp3, etc), you will be able to see it in this pop up as well. From this context 

menu you can also choose to edit or delete the note or download the attached 

file. The paper clip icon next to Add allows you to attach media (or any kind of 

file) to the note. 
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Figure 26. View Note 

 

1.5.7.  Redacting Recordings in an Incident 

Redaction is an umbrella feature allowing for modifying part of a call’s audio, 

either by replacing it with silence or a tone, or by applying an effect such as 

obfuscation or automatic gain correction. Obfuscation transforms the original 

speaker’s voice into something clear but not recognizable as a specific person 

and aims to make identifying a source difficult. 
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Figure 27. Redaction in Context Menu 

 

Redaction points are available only for calls organized into an incident. Right-

click on a call record to add a Redaction point. This will show up as a purple 

highlighted space in the call, with a smaller square in the upper right corner. 

Clicking that square gives the redaction space focus, so you can adjust its 

duration by dragging the start and end times, or adjust its location by click in 

the center and dragging it from side to side. 

Figure 28. Redaction Area 

 

If you right-click the Redaction area, a Redaction specific menu will pop up. 

From here, you can open an options menu for this redaction, change the kind of 

effect to be applied (Mute, Tone, AGC, or Obfuscate), “Move” the redaction by 
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giving it mouse-focus the way clicking the upper right corner would, or remove 

the redaction entirely. 

 

Figure 29. Redaction Menu 

 

The Options for a Redaction include the maximum gain of the AGC, or the kind 

of Obfuscation. A lower value for Obfuscation modulates pitch downward, and a 

higher one moves it upwards.  

1.5.8.  Incident Clip Management 

Incident Clip Management is a feature intended for systems that use analog 

recording with imperfect call stop and start recording criteria. On systems 

relying on Vox or TRV thresholds and hold times, sometimes a single call will be 

recorded as two, and other times two calls can be recorded in a single call. 

Incident Clip Management allows users making incidents to join or split audio 

calls in an incident so that the calls are played back correctly. The original call 

records remain on the recorder in their as-recorded state. 

A split or joined call record is called a clip. 

ICM Configuration and Permissions 

Incident Clip Management is an optional feature: for anyone on the system to 

use it an Admin user must turn the feature on in Configuration Manager under 

Users and Security: System Security. When enabled, this will add two custom 

fields required for ICM, is_clipped_media and clip_details, if they do not already 

exist. At that point, any Admin or Researcher user can use ICM. 
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Figure 30. Enable Incident Clip Management in Configuration Manager 

 

Joining Calls with ICM 

Once configured, the tools to split and join media are relatively straight forward. 

Note that this function is only available for use on call records in an incident. 

Below is an example image showing a call that split because the volume of the 

audio dropped too low for too long, causing it to be broken into two calls. 

Figure 31. Example Call Improperly Split because of Vox Threshold Level 

 

In order to fix this: 

1. Add both calls to an incident and select one of the calls, right-click and 

select “Split/Join Media” from the context menu. 



   

36  Chap. 1.  Using MediaWorks Plus MediaWorks Plus User Manual v2.6.1   

Figure 32. Step 1: Select Split/Join Media from Menu 

 

2. The Split/Join Area will appear; this is very similar to the Redaction tools 

previously discussed. 

 Figure 33. Step 2: Split/Join Area  

 

3. Drag the edges of the Split/Join Area to contain the call audio. 

Figure 34. Step 3: Resize Split/Join Area to Include All Audio 

 

4. And then click the green check box to merge, or the red X to cancel.  

Figure 35. Step 4: Click Green Checkbox and then Click OK 

 

5. You then get a summary of what will be joined, with the option to remove the 

original records from the incident. In the case like this, of joining two calls, 

you are going to want to use the default setting to remove the original two 
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from the incident. The original calls remain on the recorder, but are replaced 

in the incident with the new joined call. The call grid will be updated with 

the new call as well. 

Figure 36. Step 5: The Calls are Now Joined 
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Splitting Calls with ICM  

Here we will tackle the other common scenario: a pair of calls that are joined 

together because the Vox hold time was set too long and the calls were very 

close together in time: 

Figure 37. Example of Calls Improperly Merged Because of Vox Timeout 

 

1. As above, click the call and use the context menu to Split/Join Media, and 

then adjust the boundaries to surround the first call, click the green check 

mark. 

 Figure 38. Step 1: Adjust Split/Join Area  

 

2. In this case, we want to uncheck the default “Remove original record(s) from 

incident” option: we want the original to remain in the incident for the next 

step. We are going to crop a second call out of it and at that point we will use 

the default setting to remove the original. 

Figure 39. Step 2: Uncheck “Remove original record(s) from incident” 
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3. Click OK. The selected area is now added to the incident as a separate call. 

The original remains. 

Figure 40. Step 3: First Call Split, Original Call Remains 

 

4. Again, use the context menu to click Split/Join Media and select the second 

call’s audio area. 

Figure 41. Step 4: Select and Split the Second Call 

 

5. Click the green check mark and click OK on the prompt (leaving the default 

setting.) 

Figure 42. Step 5: Split the Second Call and Remove the Original Call from the Incident 

 

6. Now both calls exist in the incident as separate call records, shown 

accurately in the timeline and call grid. 

Figure 43. Step 6: The Calls are Split 
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More about ICM  

Calls that have been split or merged with ICM will appear in search results at 

the same time as the original calls. ICM calls are always displayed on top in the 

timeline; they are also highlighted with a yellow border, as seen in the screen 

shots above. Enabling the call grid column Is Clipped will also let you quickly 

see whether a call was modified with ICM or not. 

In an incident, you can quickly access the original version of a clip by right-

clicking it and selecting “Restore Original Media” to bring all original calls 

involved into the incident. There is an option to remove the clip from the 

incident in the same step. 

If a clip is no longer useful (or created wrongly in the first place) it can be deleted 

from the recorder by right-clicking it and selecting “Delete Clip.” It is important 

to note that if a clip is used in multiple incidents, it will no longer be available in 

any of them. 

1.5.9.  Pinning Media to an Incident 

Multimedia in an incident can be “pinned” to the canvas, such that they are 

always shown when the incident is loaded. This is so that important events in 

an incident can be highlighted for future research. In an incident, a multimedia 

record, such as a screen capture, will playback in a panel that has these options 

in the upper right corner: 

Figure 44. Multimedia in an Incident (Detail) 

 

The left most of these icons is the Pin to Incident button. If you click this, the 

frame around the media will turn grey and the Pin to Incident and the Pop Out 

to Application will disappear: 
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Figure 45. Pinned Multimedia in an Incident (Detail) 

 

1.5.10.  Exporting an Incident 

Incident Export exports the entire incident based on the export default. The only 

difference is that it always selects “All Media” on the first panel because 

otherwise it would only export the currently selected calls. If you want to modify 

the export settings from the default, you can click the Back button to adjust any 

of them. 

Figure 46. Export Incident 

 

Exporting an incident with this button will also include all attached files in the 

resulting zip file rather than requiring you to download each one individually 

from the Properties and Notes page. 

For more details on Exporting, see section 1.7. Exporting Recording Data from 

an Incident. 

1.6.  Updating Recordings 

Once recordings have been collected into incidents, there are a number of ways 

to examine their properties. Examine detailed properties for any recording by 

right-clicking a recording and selecting Properties from the menu. The Properties 

dialog box will appear, allowing you to add information such as notes and to 

access the audit history of the recording. 

Any notes modified in this dialog box are saved back to the recorder on which it 

originated. Similarly, changing the Protected status of a recording updates the 

recording’s status on the source recorder. 
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1.6.1.  Call Properties Screen 

The Call Properties screen lists the attributes of the selected call recording and 

includes the following tabs: 

 Properties – provides information about the call properties. See Figure 23. 

 More – allows you to add information about the call. See Figure 24. 

 History – Provides a history of the call. See Figure 25. 

Call Properties Screen – Properties Tab 

The Properties tab provides detailed information about the recording’s location, 

time, and phone. You may add information about the recording in the Notes 

box. Check the Protected box in the Attributes section to prevent the recording 

from being deleted. 

Figure 47. Call Properties Screen –Property Tab 

 

Call Properties Screen – More Tab 

The More tab includes the custom fields specific to your recorder that contain 

additional information about the recording. From this screen, you may edit any 

of the custom field information. 
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Figure 48. Call Properties Screen –More Tab 

 

Call Properties Screen – History Tab 

The History tab provides an audit history of each time this recording has been 

accessed, including the related user information. 

Figure 49. Call Properties Screen –History Tab 
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1.6.2.  Annotating Calls 

Annotation allows you to make notes in a recording at the precise time in the 

recording that is of interest. For example, you can mark where someone on the 

line starts yelling, or when a sound in the background caught your attention. 

Annotations are visible on the timeline as a little yellow pin marker, and if you 

hover your mouse over them, the text will pop up, in this case “A comment 

about this moment in time.”: 

Figure 50. Annotation in the Timeline 

 

Annotations are paired to the call, so the pin will be visible in any search, 

browse or incident that includes it. To add an annotation, right-click on the call 

and select Add Text Annotation. This will open the Annotation editor, with the 

Date set to the time of where you initially clicked. 

Figure 51. Editing an Annotation 

 

You can adjust the time alignment by configuring the date in this window. 

When looking at the properties of a call record that has been annotated, a list of 

these annotations will appear at the bottom of the properties window. 
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Figure 52. Properties showing Annotations 

 

1.6.3.  Audio Annotations 

Annotations can also include audio, if you have a microphone attached to your 

computer and are using Firefox or Chrome. Internet Explorer does not yet 

support the necessary web technologies for this feature to work. 

For privacy reasons, using a microphone with MediaWorks Plus requires that 

you grant explicit permission to the web browser to use the microphone; this is 

handled by the browser  

Figure 53. Audio Annotation Microphone Permission Prompt in Firefox 
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Figure 54. Audio Annotation Microphone Permission Prompt in Firefox 

 

Audio Annotations can include text like a regular Annotation, but by using a 

microphone you can provide commentary on any call, at any point in the call. 

Right click on the call in the timeline at the point you wish to annotate, grant 

permission to the microphone (once per session) and then click the button with 

the red dot in a circle to start recording. 

Once you are recording, the timer on the side will count up to the maximum of 

60 seconds of recording time. Click the same button again to stop recording. 

You can then playback the recording by pressing the play icon (triangle) in the 

audio widget that appeared after clicking stop. 

You can delete the recording by pressing the red X circle button and you can 

save by clicking OK. Playback the call and you will hear the audio annotation, 

surrounded by a beep at start and end, at the point in the call you placed it. 

Audio Annotations are played back by default but can be turned off in the 

Playback menu. 

 

Figure 55. Audio Annotation Error: No Microphone 
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1.7.  Exporting Recording Data from an Incident 

MediaWorks Plus can export recording data from a recorder in a number of 

different formats. Although you can export from the Search and Browse tabs, 

the preferred way to export data is to first create an incident containing the 

recordings you wish to export. Refer to Section 1.5 Creating an Incident for 

additional information. Once an incident has been created, select Export… from 

the Tools menu. The Export Media dialog box will appear, Figure 38. You can 

also right-click on the selected recordings in the Record view and choose 

Export… from the menu. 

1.7.1.  The Export Dialog Box 

To export recordings: 

1. The first step in the Export Media dialog box, Select media, will be 

highlighted. Select All media in your record list? to export the media for all 

of the recordings in the incident, or select Only selected media in your 

record list? to export only selected recordings in the incident.  

2. By default, a text file listing the calls and metadata will be included in the 

resulting zip file; this can be exported as a PDF as well. The PDF option 

allows you to configure which Metadata Columns to include in the PDF, as 

this may need to be adjusted in order to fit the data onto a single page. 

3. You can also choose to Include Attachments, for incidents that include 

attached files. Make your choice and then click the Next > button. 

Figure 56. Export Media Dialog Box Step 1 
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4. The second step, Select File Divisions, will be highlighted. You may select 

One file per record (sequential), one file for the entire record list 

(sequential), which exports all of the calls back to back in order in one file, 

One file for the entire record set (mixed), which means it is presented in 

real time will overlapping calls audibly overlapping, or One file per resource 

(mixed), which exports a single mixed file for each resource involved in this 

export. 

The two Mixed exports have additional options that do not apply to the 

sequential mode: Skip Inactive Periods and Apply Boundaries. Skip 

inactive periods will skip any part of the export that would have been silent, 

useful when exports have long periods between calls. Apply Boundaries 

allows you to crop the export to a shorter duration that the data set chosen 

in the first step. 

Make your choice and then click the Next > button. 

Figure 57. Export Media Dialog Box Step 2 

 

5. Select Export Options, will be highlighted. Here you can select Talking 

Time (and then choose the desired talking time modes), choose to use the 

timeline playback settings, and set the file type to save as. In the File output 

encoding box, select the type of data compression scheme you want to use. 

If you have purchased and entered an add-on license for MP3 encoding, MP3 

will be an available choice in this menu. 

The Use timeline playback settings and apply redaction areas option is 

on by default and will cause exports to sound the same as they do when 

played back in the same mode as the export, including volume adjustments, 
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AGC, panning and redaction areas. The Export Audio Annotations option 

will include any audio annotations present on the calls being exported. 

After selecting the audio options, click the Next > button. 

Figure 58. Export Media Dialog Box Step 3 

 

 

6. The fourth step, Select destination, will be highlighted. Enter a file name 

for the export, and select Export to File, Export to Data CD/DVD/Blu-Ray or 

Email Export. Export to File will create a zip file containing the exported 

calls for use on your computer. Export to Data CD/DVD/Blu-Ray will 

create an ISO that can be burned with standard cd burning software to the 

appropriate media for the size of the export; the export dialog will show you 

whether the estimated size of the export will fit on each of the kinds of 

media. Email Export will create a EML file that will automatically open in 

your computer’s configured default email client. 
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Figure 59. Export Media Dialog Box Step 4 

 

7. Optional: Export Presets and Defaults can be configured from here. See 

below for details. 

8. Finally, click on the Export button to export the recording data; it will be 

downloaded to your browser’s default download location on your PC. If you 

selected Export to File, it will download as a zip folder containing the audio 

file or files you requested. 

If you selected Export to Data CD/DVD/Blu-Ray, the file downloaded will be 

an ISO file that you can use Windows Disc Image Burner to burn to cd or 

DVD. If you have a Blu-Ray drive please use the image burning software that 

it came with. 

1.7.2.  Export Presets And Default 

Regularly used Export settings can be saved, both as a default setting that will 

load every time the Export dialog is opened, and as individual Export Presets 

that can be selected from the “Export Using Preset” menu option. Defaults and 

presets are saved at the last panel of the Export dialog. 
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Figure 60. Saving Export Default and Presets 

 

Clicking the Export Presets… button will prompt you to save the current settings 

as either a default export configuration or as a named preset. Once an Export 

Preset has been saved, the Tools menu and the right-click context menu will 

have a new Export Using Preset option that allows you to choose a preset to 

load. 
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Figure 61. Export Using Preset Menu Option 

 

Selecting an Export Preset will open the Export dialog to the final page, where 

you enter the export name and choose the file type (zip, ISO, eml.) You are 

however free to use the back button to make any adjustments to the settings 

that you wish for this export. 

You can overwrite an existing preset by saving a newly created one with the 

same name. You will be prompted to be sure, and if you click yes, it will 

overwrite the previous preset. To delete a preset, select that preset from Export 

Using Preset and then click Export Presets; instead of a field to save a new 

preset, you will see the option to delete this preset. 
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Figure 62. Deleting an Export Preset 

 

 

1.7.3.  Email Export 

You can choose to export to an .eml file that you can open with your email client 

of choice. It will create an email with the export’s contents attached. Note that 

your email provider usually has a limit set on the size of email attachments, so 

this option is most useful for small exports. 

1.7.4.  Export Single Recording 

Available from the Tools menu and the right-click context menu, Export Single 

Recording exports the currently selected call, with current playback and timeline 

settings, including volume adjustments, AGC, panning and redaction areas. This 
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is a quick way to export a single call at a time without any additional steps or 

menu-diving. 

1.7.5.  Screen Capture Export 

Screen capture recordings can be exported much like audio recordings, but 

there are some caveats. Recordings from multiple screen resources cannot be 

mixed together. Screens from the same channel can be merged into a single 

mixed mode export. Audio calls can be mixed with screen recordings from a 

single screen resource. If part of the export overlaps such that there is audio 

with no video, the video will be black during that time. 

There are four encoding types for screen export. The first two, MPEG, High and 

Medium, are much higher quality in a much smaller file size, but require VLC or 

Chrome or other third party software for playback. The second two, AVI Low and 

Medium Compression, will work on a stock Windows XP system, but the quality 

is lower and the file size is very large. These options are included to allow for 

maximum compatibility. 

1.7.6.  A Special Note About Internet Explorer 8 

Internet Explorer 8’s default settings will prevent exporting from working 

properly, but it is easy to make it work. If you export a call and see this text “To 

help protect your security, Internet Explorer blocked this site from downloading 

files to your computer. Click here for options…” (as seen bellow in the yellow), 

then you have default settings and need to take action to allow exporting to 

work. 

Figure 63. Export Blocked by Internet Explorer 8 

 

Unfortunately Internet Explorer 8 does not handle this situation as smoothly as 

it could and if you click there and select “Download File…” instead of 

downloading the file, it will refresh the browser page, so you should save any in 

progress work before proceeding. The upside is that once you click “Download 

File…” your recorder is approved for all future downloads from this PC and you 
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will not see this again. If you were exporting from a saved incident, the incident 

will reopen and you can export again, otherwise you will need to recreate the 

search that you used to find the calls for export. 

Figure 64. Download File… in Internet Explorer 8 

 

1.8.  Monitoring a Recorder 

MediaWorks Plus allows you to monitor the live audio feeds on the recorder. In 

addition, you can view the current status of channels, and (if permitted) 

manually enable/ disable recording on channel(s) for record-on-demand 

purposes. 

1.8.1.  Channels Tab 

The Channels tab, Figure 35, displays all physical channels in a list and 

provides live status information for all physical channels on the recorder. To 

open a new Channels tab, select New Tab -> Channels from the File menu. 

To sort the list of channels, click on either the Channel Name or Channel 

Number header; a small arrow will indicate the sort direction. To reverse the 

sort, click the header section again. 

Each channel is displayed with the Channel Name, Channel Number, and 

current Channel Status. To enable live monitoring of the data currently playing 

on a channel, click to toggle the Live Monitor icon for the selected channel. 

Multiple channels can be monitored simultaneously. Adjust the overall volume 

level using the volume slider at the bottom of the window. 

To enable recording on a channel, check the Record Enabled checkbox. If the 

checkbox is deselected, any audio currently being recorded will stop until the 

Record Enabled checkbox is re-checked. 

 Note: The Record Enabled feature is heavily restricted, and must be configured 

explicitly for each user, even those with Administrator rights, in Configuration 

Manager. This is to prevent accidental use of the feature. 
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Figure 65. Channels Tab 

 

The status of each channel is displayed in the Channel Status column. A colored 

square indicates the current status. The colors correspond to the following 

states: 

 Green – The channel is enabled, but not currently recording any audio. 

 Red – The channel is enabled and is currently recording audio. 

 Yellow – The channel is disabled. 

 Grey – The channel is disabled by the system or is not recognized. Consult 

your system administrator for details. 

You may add more columns by right-clicking on any area in the column headers 

and selecting one or more new columns from the drop-down list of column 

names. Check the box associated with each column name you wish to add and 

the new column will appear in the Channels tab. To remove a column, uncheck 

the box associated with that column. 

1.8.2.  Instant Recall Tab 

The Instant Recall tab, as seen below, provides a live window into the activity 

on one or more channels. The most efficient method for monitoring a recorder 

with Instant Recall is to create one tab per filter. See Section 1.10. Search Filter 

Groups. 
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Figure 66. Instant Recall Tab 

 

To open a new Instant Recall tab, select New Tab from the File menu and select 

Instant Recall from the drop-down list. 

The Instant Recall tab’s main controls are positioned at the top of the screen 

and include: 

 The Choose Channels… button, which will pop open a list of Search Filter 

Groups and resource names to filter the call resources shown in the instant 

recall window. 

 An adjustable time period that allows you to set the time window for which 

records will appear. 
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Figure 67. Choose Channels… pop up menu 

 

The records displayed in the record view will correspond to the selected filter, 

and will also correspond to the specified time range. 

The Choose Channels… pop up menu lists your Search Filter Groups first and 

then each named resources. The channels viewed are selected via mouse click; 

use Ctrl+Click or Shift+Click to select more than one at a time: 

 Clicking on Channel 1 and then ctrl+clicking on Channel 9 will select 

just Channel 1 and Channel 9. 

 Clicking on Channel 1 and then shift+clicking on Channel 9 will select 

Channel 1 through Channel 9. 

To adjust the time range, enter a new value for Hours and Minutes. Instant 

Recall will automatically refresh the record view. To change the channel that is 

displayed, select a new channel name from the drop down list. The record view 

will again be automatically refreshed. 

 Note: Depending on your user account, the amount of time you can set may be limited 

by your system administrator. 

The Instant Recall record view can be customized by right-clicking on any area 

in the column headers. A drop-down menu with a list of column names will be 

displayed. To add a new column, check the box associated with the column 

name. To remove an existing column, uncheck the box associated with that 

column name. 
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Columns can also be re-arranged. To move a column to a new position, click on 

the column header, hold down the mouse and drag the column header to a new 

position, then release the mouse. The column will then re-position itself.  

Instant Recall Timeline 

Each Instant Recall tab also includes a Timeline view in the bottom half of the 

page. This allows for all of the features standard to the Timeline view as seen in 

the Browse and Search tabs, as discussed in chapter 1.4.4 The Timeline View, 

but also includes some special features unique to the Instant Recall tab: 

 Per channel live monitoring of incoming call via Resource Name or 

Talkgroup. 

 Optional up to the minute timeline scroll. 

Each resource in the Timeline has a speaker icon at the far right that can be 

toggled green to have it live monitor all calls coming in with that resource name. 

This is different than the Channels tab, which is by physical id number only. 

Figure 68. Instant Recall Tab 

 

The blue arrow in the right corner toggles whether the display of the timeline is 

locked to the current time or not. It will automatically turn off if you play a call 

in the timeline or scroll into the past, and if you then click it, it will jump 

forward to display the current time. It will also turn back on if you live monitor a 

resource, or if you scroll all the way up to the right to the current time. 

Figure 69. Up to the Minute Arrow (Left is On, Right is Off) 
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1.9.  Geolocation Features: Geo-Display and Geo-Fence 

Call records can now be tagged with location metadata and that data can be 

used to visualize where calls are coming from. The location data can also be 

used as a criteria for searches. 

1.9.1.  Geo-Display 

The View menu includes an option called “Enable Geo-Display.” 

Figure 70. Geo-Display 

 

On a system with a Geolocation add-on license and location metadata, when 

Geo-Display is first enabled it will open the Geo-Display popover window, shown 

in the above figure, featuring a map and pin marks for call records in the 

current timeline that are tagged with location data. Note that Geo-Display is 

supported in all tabs except Evaluations and Channels. 

The + icon will expand the Geo-Display to cover as much of the browser page as 

possible, and the – will bring it back to the default smaller size. With the X, the 

window can be minimized to a Globe button just above the call record grid in all 

tabs that support Geo-Display, as seen in the figure below, next to the “1999 

records, 0 selected”: 
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Figure 71. Geo-Display Minimized 

 

The Geo-Display defaults to showing you pin points for each call record, on a 

street map. These pins can be clicked on to select the record in the call record 

list and in the timeline, double-clicked to play, and right-clicked to access all of 

the context menu options you have when right clicking from the timeline or call 

record list. Much like on the timeline, selected records are displayed as blue 

pins and the currently played call is green. 

Additionally, the Geo-Display offers other display options, if you click the white – 

in a blue box near the top right corner: 

Figure 72. Geo-Display Options 

 

The Base Layer options allow you to toggle between Google’s Satellite and Streets 

views. The Satellite view shows you the actual terrain, whereas the Streets 

shows you a street map. 

The Heatmap option shows you your data in shades of color generalized by 

density of results. It is more useful when looking at a lot of data at once; with 

enough call records, individual pins will pile up into a mess, but a heatmap will 

show you hotspots where more of your calls are coming from. It’s easier to 

understand with a picture: 
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Figure 73. Heatmap Example 

 

The dark blue areas show you one or two calls, but the bright green areas show 

you where calls came in repeatedly during the time covered by this search. 

1.9.2.  Geo-Fence 

The Search tab includes a Search Filter option called Geo-Fence: 

Figure 74. Geo-Fence in Filters Menu 

 

The Geo-Fence allows you to draw shapes on a map, which will be used to filter 

search results to just that territory: 
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Figure 75. Geo-Fence in Filters Menu (Polygon Selection in progress in blue) 

 

For better ease of use, you can pop this Geo-Fence out into its own window 

inside the MediaWorks Plus browser page: 

Figure 76. Geo-Fence Pop Out (with two polygonal search areas in orange) 
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There are five tools and an Options menu in the upper right corner of the Geo-

Fence: 

Figure 77. Geo-Fence Tools and Options 

  

These tools are, from left to right: 

1. Circle: Draws a circle on the map, with the initial click being the center and 

then the circle’s size is determined by dragging away from the initial click. 

2. Polygon: Each click becomes a point of a polygon, allowing for customized 

shapes. Double click a point to finish the polygon. 

3. Point: This creates a circle of pre-determined size. The default is 3 miles but 

that is configurable in the Geo-Fence options. 

4. Hand: The Hand tool is used to drag the map around.  

5. Clear: This X icon will clear existing shapes and allow you to start over or 

search without the filter active. 

The Geo-Fence options are the same the Geo-Display options, but also include 

Search Settings: 

1. Single Mode: This restricts the search area to a single area at a time; making 

a new search area will delete any previously created search area in favor of 

the new one. 

2. Point Search Miles: This is the size for the Point tool. It defaults to 3 miles. 
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3. Save Location and Settings as Map Default: This saves current settings and 

location as the default, so that every time you open a map it’ll show the area 

currently shown with the settings as they are. 

Here is an example of a search made with the circle tool: 

Figure 78. Geo-Fence Tools and Options 

 

1.9.3.  Radio ID Display for Instant Recall 

The Geo-Display feature Show Radio IDs only works with Instant Recall tabs: 

Figure 79. Geo-Fence in Filters Menu 
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This feature allows you to see Talker ID and Group ID (or really any Metadata 

field) on the associated call pin as calls come into the recorder. The recall 

minute setting controls how long this data shows on the map, fading over time 

so that the latest calls are the most prominently displayed. 

1.10.  Resource Search Groups 

A “Resource Group” is a NexLog policy management tool that groups together 

resources/channels on the recorder and allows different rules to be applied to 

them. Search Filter Groups are a special kind of Resource Group, which make 

large channel count systems easier to interact with by grouping existing 

resources into easily searched groups. To differentiate these from the Saved 

Search Filters feature of MediaWorks Plus, they are referred to as Resource 

Groups in this context. 

Resource Search Groups can be edited via the Tool menu at any tab. They are 

also Edit Resource Groups… options in contextually useful places on the Search 

and Instant Recall tabs, as described below. Finally, Search Filters can also be 

edited from the Configuration Manager on the Resource Groups page and User 

Edit pages; see the NexLog 2.4 manual for more info. 

1.10.1.   Creating Resources Groups for Search 

The Edit Resource Groups option in the Tools menu allows you to edit 

Resource Group Search Filters, you will see this window: 

Figure 80. Edit Resource Groups Window 
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There is a similar Edit Resource Groups… option in the Choose Channels… 

menu on Instant Recall tabs, which opens the same window. 

The Edit Resource Groups window has two columns. The left column is contains 

a list of search filter groups configured to be available for the current user. The 

right column contains in bold all existing filter groups not configured for the 

user, and in plain text the available channel resources, first the physical 

channel ids and then by resource names. The physical channel ids are 

formatted like this: 

 [source] channel id “current name of resource” 

Such that the first physical channel on the recorder itself will default to: 

 [local] 1 “Channel  1” 

The << and >> buttons are used to move filter groups, channel ids and resources 

between the two columns. 

From this edit window, you can add and delete Resource Groups in a number of 

ways. To create new groups: 

 The first is to click the New Group button. This will prompt you to name 

the group, then click ok. An empty group of the name entered will be 

created. 

 You can also right click an existing group and select Add New Group 

Resource Groups can only be deleted by Administrators and users with access 

to the Resource Groups page of the Configuration Manager. 

1.10.2.   Adding Resources to Resource Groups 

From this edit window, you can add resources to a Resource Groups in a 

number of ways: 

 The named resources and physical channel numbers in the right column 

can be clicked on to select them. Use Ctrl+Click or Shift+Click to select 

more than one at a time. Highlight a group in the left column by clicking 

on it. Then add the selected resources by clicking the leftward facing 

arrows between the columns. 

 You can select resources and click+drag them from the right column into 

the group you want them to be added to. 

 You can right-click the name of the group and select from a menu, as 

seen in the figure below. From this menu, you can add a Name Filter, 

using * as a wild card to match multiple resources by name. 

 This menu also allows you to add a Channel Filter, with which you can 

specify a range of resources by physical channel ID and their source, 

which defaults to Local. The source field is only relevant to 

configurations involving resources on the recorder originating from 

Centralized Archive sources; if you want to group these, enter the serial 
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number of the Centralized Archiving source into this field. Click the X to 

cancel and the Checkmark to save. 

Figure 81. Edit Resource Groups: Right Mouse Button Menu 

 

These filters are then For example, if you have some channels dedicated to Fire 

calls and others dedicated to Police, you can create a Resource Groups for the 

Police channels, and another for the Fire channels and quickly search all calls 

on one group of channels. 

1.10.3.   Deleting a Resource from a Resource Group 

You can delete resources from a Resource Group in two ways. First expand the 

group in the left column and then: 

 Select the resources you want to remove from the filter and then click the 

>> button between the columns. 

 Right-Click on the group and select Remove Filter from the pop up menu. 

1.10.4.   Using Resource Groups 

These filter groups now show up in the channel selectors for Browse, Search and 

Instant Recall. Updates made to Resource Groups are live and do not require a 

refresh of the browser to take effect. 

Figure 82. Resource Groups: In Browse, Search, and Instant Recall 
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1.11.  NexLog Access Bridge  

MediaWorks Plus can be used to access recordings across multiple recorders at 

once using NexLog Access Bridge (NAB). With NAB, NexLog Recorders can be 

bridged together to allow access to media across systems from one instance of 

MediaWorks Plus, and if the same User & Password is used across systems, one 

log in. For example, one system can be a dedicated screen recorder, and another 

can record related phone calls, and both sets of recording can be browsed and 

played back at the same time, from the same MediaWorks Plus window. 

NexLog Access Bridge requires a NAB License on the primary recorder and a 

MediaWorks Plus license on each of the source recorders. 

1.11.1.   Connection Information 

The Connection Information window shows you all of the NexLog systems and 

archives that are currently configured or available to connect to at this moment. 

This includes all configured NexLog Access Bridges and all Archives attached to 

the base system and put into Playback mode via the Browse button the Front 

Panel or from the Archives page of Configuration Manager. 

You can access Connection Information by selecting Connection Information 

from the View menu. If you turn on Show Connection Icon, a small Connection 

Icon will show up next to the user name in the upper right and you can click on 

it to bring up the Connection Information window at any time. 

Figure 83. Connection Information Window 

 

The column headers are Recorder Name, Username, Serial, Status, Location, 

Ping(s), Connect Now, and Connect on Startup. 

Most of the headers are self-explanatory: for example, Recorder Name and Serial 

are the name and serial of the configured recorder. The Username is the user 

name you are currently logged in to this source as. The Location is the IP 

address of this recorder. Status and Ping(s) are interesting because you can click 

on any entry under this field and get more information: a list of the previous 

statuses and the previous ping durations. 
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Figure 84. Connection Information Status History 

 

Connect Now and Connect on Startup allow you to manage your connections to 

bridges and archives. If Connect Now is unchecked, you are disconnected from 

the source (and Status should then say Disconnected or Unavailable.) 

If Connect on Startup is checked, an attempt will be made to log in to that 

source whenever MWP on the base recorder is logged into by this user. If the 

user credentials for the base recorder are not valid on the source, there will be a 

prompt to log in with a different name and password. 

When there is a problem with a connection, you will be prompted with a warning 

detailing why, and then given the option to Login, Ignore, and Logout. If, 

however you also have unsaved incidents or evaluations, it will prompt you just 

to Login or Logout. 

Figure 85. Connection Prompt with Error Messages 

 

Login will prompt you for credentials to log in with; if you were already logged in 

as a specific user, you will be required to log in as that user, to maintain 

continuity of permissions during this session.  

Ignore will cancel the attempt to connect to this source. If you want to, you will 

then have to manually re-connect via the Connection Information window. 
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1.12.  Archives 

As of 2.4, Archives can be accessed via MediaWorks Plus. To connect to an 

archive, load the archive as appropriate for the kind of archive on the primary or 

any connected NexLog bridge system, and use the browse button to load the 

archive into “Playback” mode. The archive will then connect automatically for 

MediaWorks Plus users who have permissions to read from archives. You can 

disconnect from them via Connection Information. 

You can use Search, Browse, and Export features on connected Archives; 

Incidents and Evaluations of archived calls are not currently supported. 
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  

2.   More about MediaWorks Plus 

2.1.  Columns 

Any data displayed in tabular format, particularly lists of recordings available in 

the Browse, Search, Incident, and Channel tabs, can be sorted in ascending or 

descending order, if applicable, by clicking on the header for that column. An 

indicator arrow will appear in that column indicating the sort direction. To 

change the sort direction, click on the column header again. 

You can also sort columns by a secondary sort by Shft+Clicking a second 

column. For example, you may want to sort by channel name and then by start 

time; you would click Channel Name first, then hold down the shift key and 

click the Start Time (Local) columns. You can change the secondary sort by 

again shift+clicking, or you can cancel the secondary sort by clicking on any 

column, which will then be the only sort criteria. 

Columns can also be re-arranged. To move a column to a new position, click on 

the column header, hold down the mouse, drag the column header to a new 

position, then release the mouse. The column will then re-position itself. 

Figure 87. Column Drop-Down List 
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The presentation of recordings in the Browse, Search, and Incident tabs can be 

further customized. Right-clicking on any area in the column headers displays a 

drop-down menu of possible column names. To add a new column, check the 

box of the associated column name. To remove an existing column, uncheck the 

box associated with that column name. 

2.1.1.  Calltype 

Figure 88. Calltype column 

 

Calltype is a feature in introduced in NexLog 2.4 that automatically tags records 

with an image representing the kind of recording it is. By default, recordings 

made on Eventide Larch Analog Recording cards will be tagged with Audio, 

T1/E1 with Phone, screen capture with Screen. 

In MediaWorks Plus, these icons will appear in the timeline if Show Calltype in 

Timeline is checked in the View menu. You can see the Calltype column by 

making the column visible as you would any custom field by right-clicking in the 

call grid and selecting Calltype from the list. 

 Figure 89. Calltype in Timeline  

 

If the default mapping isn’t appropriate for a channel, you can configure it per 

channel in Configuration Manager. See the section about Calltype in the NexLog 

Manual.  
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2.2.  The Menu Bar 

The Menu bar is located at the top of the MediaWorks Plus window. A number of 

menu selections have shortcut keys associated with them and are displayed to 

the right of the menu selection. Also, if a menu selection includes an associated 

shortcut key, the shortcut key is shown parenthetically in the following 

descriptions. 

The Menu bar includes the following menu items: File, Edit, Tools, Playback, 

View, and Help. 

2.2.1.  File Menu 

Figure 91. File Menu 

 

Selecting File from the Menu Bar provides the following menu items: 

New Tab 

The New Tab menu item opens a new tab in the active top-level window. Choose 

a tab name from the list that appears. The list includes: 

 Browse (Ctrl+B) 

 Search (Ctrl+T) 

 Incident (Ctrl+I) 

 Channels (Ctrl+L) 

 Evaluations (Ctrl+G) 

Open Incident… (Ctrl+O) 

The Open Incident… menu item opens an existing remote incident in a new 

tab. 
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Close Tab (Ctrl+W) 

This menu item closes the active tab. You cannot close the last tab. 

Save Incident (Ctrl+S) 

The Save Incident menu item saves the active incident. If an Incident tab is not 

active, this option is not available. 

Save Incident As… (Ctrl+Alt+S) 

This menu item saves a copy of the active incident by prompting for a new 

incident name. If an Incident tab is not active, this option is not available. 

Logout (Ctrl+Q) 

Selecting the Logout menu item logs the user out of the NexLog recorder, and 

will go back to the initial splash screen with a login prompt. There is an “Are you 

sure” prompt. 

2.2.2.  Edit Menu 

Figure 92. Edit Menu 

 

Selecting Edit from the Menu Bar provides the following menu items: 

Select All (Ctrl+A) 

The Select All menu item selects all recordings in the active tab. 
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Remove From Incident (Ctrl+D) 

Selecting the Remove From Incident menu item removes the selected 

recordings on the active Incident tab. If an Incident tab is not active, this option 

is not available. 

Incident Properties (Ctrl+J) 

The Incident Properties menu item invokes the Incident Properties dialog box 

on the active Incident tab. If an Incident tab is not active, this option is not 

available. 

New Incident from Selected Records (Ctrl+Shift+I) 

This menu item creates a new Incident tab in the active window containing all 

the selected recordings. If a list of recordings is not available in the active tab, 

this option is not available. 

Set Loop Start to Current Time (Ctrl+[) 

This selection sets the “loop start” point to the value of the current playback 

time. This is only available on those tabs that can play audio from a recording. 

Set Loop End to Current Time (Ctrl+]) 

This selection sets the “loop end” point to the value of the current playback time. 

This is only available on those tabs that can play audio from a recording. 

Set Export Start to Current Time (Ctrl+Shift+[) 

This selection sets the “export start” point to the value of the current playback 

time. This is only available on those tabs that can play audio from a recording. 

Set Export End to Current Time (Ctrl+Shift+]) 

This selection sets the “export end” point to the value of the current playback 

time. This is only available on those tabs that can play audio from a recording. 
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2.2.3.  Tools Menu 

Figure 93. Tools Menu 

 

Selecting Tools from the Menu Bar provides the following menu items: 

Refresh (F5) 

The Refresh menu item refreshes the list of recordings in the active tab. 

Stop (Esc key) 

Selecting Stop halts a refresh that may be in progress. 

Export… (Ctrl+Shift+Y) 

This menu item opens the Export Media dialog box for the current list of 

recordings. See Sections 1.7.  Exporting Recording Data from an Incident for 

additional information. 

Export Using Preset… (Ctrl+Shift+Y) 

This menu item opens the Export Media dialog box for the current list of 

recordings with the preset selected. See Sections 1.7.  Exporting Recording Data 

from an Incident for additional information. 
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Edit Search Filters... 

This menu item opens the Search Filters window. See Section 1.3.4 Saved 

Search Filters for additional information. 

Edit Resource Groups... 

This menu item opens the Edit Resource Groups window. See Section 1.10 

Resource Search Groups for additional information. 

Edit Date Formats 

This menu item opens the Date Format Options window. This window allows 

you to customize the way dates and time are formatted throughout MediaWorks 

Plus. We recommend leaving out the day, month year from the Instant Recall 

Date Format because Instant Recall will always be displaying calls from the very 

recent past. 

Figure 94. Date Format Options 

 

The default global date time format is: YYYY-MM-DD HH:mm:ss Z 

 YYYY: Four digit year 

 MM: Two digit month 

 DD: Two digit day 
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 HH: Hours (24 hour clock) 

 mm: Minutes 

 ss: Seconds 

 Z: offset from GMT time 

The hyphens and colons in between the variable names are shown as is. 

The Load Defaults button will restore the settings to the default. The examples 

show how other variable names can be used to get other results. If you have 

more complex date needs, contact Eventide support for additional information. 

Edit Default Permissions 

This menu item opens the Edit Default Permissions dialog box so that you can 

change the default permissions for Incidents and Annotations. 

Figure 95. Default Permissions 

 

Resource Gain Defaults 

Opens the Resource Gain Defaults window. See Section 1.4.4 The Timeline 

View for additional information about Resource Gain Defaults. 

Change Password 

Opens the Change Password window. Allows the user to change their password.  
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2.2.4.  Playback Menu 

Figure 96. Playback Menu 

 

Selecting Playback from the Menu Bar provides the following menu items: 

Toggle Playback (Space bar) 

Checking the Toggle Playback box starts or stops playback. Starting or 

stopping playback in this way applies to either playback mode and applies to 

any tab. The space bar on the keyboard can also toggle playback on/off.  

Start Sequential Playback (Return key) 

The Start Sequential Playback menu item starts sequential playback at the 

selected recording. If there is no selection, the first recording in the list will begin 

playing. 

Start Mixed Playback (Shift+Return key) 

The Start Mixed Playback menu item starts mixed playback at the selected 

recording. If there is no selection, the first recording in the list will begin playing. 
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Next Record (Shift+Right arrow) 

In sequential mode, Next Record skips to the next recording as listed in the 

record view. In mixed mode, Next Record skips to the start of the next recording 

in time order. 

Previous Record (Shift+Left arrow) 

In sequential mode, Previous Record skips to the previous recording as listed in 

the recording view, or skips to the beginning of the current recording, depending 

on the time that the current recording has been playing. If the current recording 

has been playing for less than 3 seconds, it will skip to the previous recording. If 

the current recording has been playing for more than 3 seconds, it will skip to 

the beginning of the currently playing recording. 

In mixed mode, Previous Record skips to the start of the previous recording. 

Skip Forward (Right arrow) 

The Skip Forward menu item scrubs forward by a user-defined number of 

seconds (default is 10). In sequential mode, scrubbing remains within the 

bounds of the currently playing recording. 

Skip Back (Left arrow) 

The Skip Back menu item scrubs backward by a user-defined number of 

seconds (default is 10). In sequential mode, scrubbing remains within the 

bounds of the currently playing recording. 

Loop Playback 

Checking the Loop Playback box loops playback between user-defined start and 

end looping points. In Sequential mode, if no user-defined start and end looping 

points have been set, the entire recording will be looped. If start and end points 

have been set within the recording, checking Loop Playback will initiate 

loopback between these two points. 

In Mixed mode, if no user-defined start and end looping points have been set, 

the entire set of recordings will be looped. If start and end points have been set 

within the set of recordings, checking Loop Playback will initiate loopback 

between these two points. 

Skip Inactive Periods 

Checking the Skip Inactive Periods box causes MediaWorks Plus to skip 

inactive periods between recordings when playing in Mixed mode. In Mixed 

mode, MediaWorks Plus always proceeds in time order and there may large gaps 
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of silence separating recordings. By default, MediaWorks Plus will skip over any 

gaps and begin playing the next recording. Disabling this option will force 

MediaWorks Plus to play the inactive periods in real time. 

AutoPlay After Cursor Move 

On by default, this option controls whether scrubbing a paused call will 

automatically start playing. If you want to move the playback position in the 

timeline while paused without having playback resume, turn this off. 

Talking Time 

Checking the Talking Time box enables talking time during audio playback. 

MediaWorks Plus will announce the time at the start of each recording (the 

talking time is mixed with the audio from the recording that has started 

playing). 

Single Play 

Checking the Single Play box stops playback in sequential mode after the data 

finishes playing for a recording. If disabled, playback continues to play each 

recording, as listed in the record view, until the end of the list is reached. 
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2.2.5.  View Menu 

Figure 97. View Menu 

 

Selecting View from the Menu Bar provides the following menu items: 

Multimedia Display Options 

Multimedia recordings can be played back in the same way as Audio calls, but 

there are additional options that relate to specifically to screens. These options 

are configured via the Multimedia Display Options window, which is described 

in detail in Section 1.4.6 Playing Back Screen Recordings.  

Enable Geo-Display 

On a system with a Geolocation add-on license and location metadata, when 

enabled this will open the Geo-Display popover window featuring a map and pin 

marks for call records that are tagged with location data. For more details, see 

the section about Geolocation in the previous chapter. 
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Show Connections Icon 

Figure 98. Connections Icon 

 

Checking the Show Connections Icon will display Connection Icon for fast 

access to the Connection Information window. 

Show Alarms Icon 

When Show Alarms Icon is selected, the alarm icon (a triangle surrounding an 

exclamation mark) at the right side of the menu bar will display. When the icon 

is grey, there are no active alarms. 

Figure 99. Alarm Icon (Nothing Active) 

 

When the icon is red, there are unacknowledged active alarms. 

Figure 100. Alarm Icon (Unacknowledged Alarm Active) 

 

When the icon is yellow, there are active alarms, but they are all acknowledged. 
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Figure 101. Alarm Icon (Alarms Active But Acknowledged) 

 

In any case, if you click on the icon, it will open the Active Alarms page of 

Configuration Manager. 

Show Reports Icon 

Checking the Show Reports Icon will display Reports Icon for fast access to the 

View Reports window. 

Figure 102. Reports Icon 

 

Show Clear Filters Icon 

Checking the Show Clear Filters Icon will display the Clear Filters Icon for fast 

access to the Clear Search Filters option. This is useful if you make heavy use of 

the Search Filters feature. 

Figure 103. Clear Filters Icon 

 

Connection Information 

This will open the Connection Information pop up window. See above in Section 

1.11.1. Connection Information. 
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Alarms 

This will open the Alarms page of Configuration Manager in a pop up window. 

Reports 

This will open the Completed Reports page of Configuration Manager in a pop up 

window. 

Archives 

This will open the Archives page of Configuration Manager in a pop up window. 

Show Export Markers 

Checking the Show Export Markers box will display boundary markers for 

Mixed Mode Exporting. These red markers default to the start and end of any 

browse or searched results, and when set within results will grey out the area 

that is not inside the boundaries. 

Show Loop Markers 

Checking the Show Loop Markers box will display the current loop points as 

blue markers in the timeline header. 

Show Calltype in Timeline 

This will show Calltype icons in the timeline. See Section 2.1.1 Calltype for more 

information. 

Show Tab Search 

This will open the Tab Search pop up. See Section 1.3.5 Tab Search for more 

information. 

Follow Playback 

Checking the Follow Playback box will cause the playback indicator to remain 

centered in the timeline as the recording is playing. 

Show Playing Record 

This option will bring the currently playing record into view on the Call Grid. By 

default, the playing record will stay in view, but if you use the scroll bar, this is 
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overridden. Using this option will bring the playing record into view and resume 

following it. 

Column Defaults 

Column Defaults will open a window to set the default columns for the call grid. 

Use the left & right arrows to move fields into or out of the list, and the up and 

down ones to reorder them. 

Save Current Columns Layout as Default 

An alternative to Column Defaults is to set up your preferred columns in the 

current tab and use this menu item to save them as the user default. This 

method has the added benefit of saving the current column widths as well. 

Warn On Exit 

With Warn On Exit checked, MediaWorks Plus will prompt for confirmation if 

you try to close the window or navigate to a different web page. 

2.2.6.  Help Menu 

Selecting Help from the Menu Bar provides the following menu items: 

Figure 104. Help Menu 

 

User Manual 

Selecting User Manual from the Help menu will open a link to this user manual 

as a PDF file. 

About… 

Selecting About from the Help menu provides information about this release of 

MediaWorks Plus. 
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  

3.  Reporting Problems 

It is Eventide’s policy to work directly with dealers. Your dealer must report your 

problem to Eventide with the following information in order to process the 

service/support request: 

 Serial number(s) of the affected recorder(s). 

 Software versions for the recorder(s). 

 Severity of the issue, including a detailed description. 

 Contact information (phone and email) for the dealer and on-site technician. 

To contact Eventide customer service for support, call 201-641-1200 Option 6 

followed by Option 2 (Communications/Recorders Division) or email 

support@eventide.com. 

mailto:support@eventide.com
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  

Appendix A: MediaWorks Plus Desktop 

MediaWorks Plus Desktop is a new standalone application that allows the use of 

MediaWorks Plus without requiring regular internet browser access. System 

administrators can download the MediaWorks Plus Desktop installer from the 

NexLog Recorder and install it for use by call takers and researchers who do not 

have web browser privileges. 

Installing MediaWorks Plus Desktop 

The download link for MediaWorks Plus Desktop is on the recorder’s welcome 

page. This page is found here: 

 http://<ip of nexlog recorder>/welcome.html 

Under Useful Links, click Download MediaWorks for Windows® 7 and higher. 

Your browser may complain that this is a rarely downloaded file. Click the menu 

on the side to say keep. 

Figure 105. Browser Warning 

 

When you launch the installer, Windows will prompt that the publisher is 

unknown. 
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Figure 106. Windows Warning 

 

Click Run. 

Figure 107. MediaWorks Plus Desktop Installer Running 

 

The installer will run and put shortcuts to the MediaWorks Plus Desktop 

executable on the desktop and in the Start menu. 
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Figure 108. MediaWorks Plus Desktop Install Complete 

 

Using MediaWorks Plus Desktop 

MediaWorks Plus Desktop functions identically to MediaWorks Plus in most 

ways. The main difference is how you connect to a NexLog recorder. MediaWorks 

Plus connects directly to the recorder, because it is a web page running in a 

browser pointed at the recorder. 

MediaWorks Plus Desktop needs to be told where the recorder is. 

Figure 109. MediaWorks Plus Desktop Login Prompt 

 

When you launch MediaWorks Plus Desktop for the first time, you will be 

greeted by a Login prompt. This window allows you to log in by providing the 

Recorder IP address or domain name as well as the User name and Password. 
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You can save these values using the Save button and then later Load any saved 

credentials from the list on the left. 

You can also choose to use any of the three options: 

 Use Domain Single Sign On; If your recorder is configured with 

Enhanced Active Directory and Single Sign On is enabled, select this 

option to log in as the currently logged in Windows User. Note that the 

Recorder field must be a Fully Qualified Domain Name (e.g. 

ExampleRecorder.ExamplePlace.Local) not an IP address for Single Sign 

On to work. 

 Use SSL: This will connect to the recorder using https:// rather than 

http://. 

 Auto Login on Startup: In the case that you always want to log in to the 

same recorder, you can select this and save the session. Then in the 

future when launching MediaWorks Plus Desktop, it will automatically 

log in to this recorder with these credentials. You can, of course, then 

logout and log in to a different recorder at any time. 

Limitations 

 Loading Local Incidents requires a connection to a recorder. 

 Screen Playback is not supported. 
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  

Appendix B: MediaAgent 

MediaAgent is a new standalone application that allows the use of MediaAgent 

without requiring regular internet browser access. System administrators can 

download the MediaAgent installer from the NexLog Recorder and install it for 

use by call takers and researchers who do not have web browser privileges. 

Installing MediaAgent 

The download link for MediaAgent is on the recorder’s welcome page. This page 

is found here: 

 http://<ip of nexlog recorder>/welcome.html 

Under Useful Links, click Download MediaAgent for Windows® 7 and higher. 

Your browser may complain that this is a rarely downloaded file. Click the menu 

on the side to say keep. 

Figure 110. Browser Warning 

 

When you launch the installer, Windows will prompt that the publisher is 

unknown. 
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Figure 111. Windows Warning 

 

Click Run. 

Figure 112. MediaAgent Installer Running 

 

The installer will run and put shortcuts to the MediaAgent executable on the 

desktop and in the Start menu. 
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Figure 113. MediaAgent Install Complete 

 

Using MediaAgent 

MediaAgent functions identically to the Instant Recall mode of MediaWorks Plus 

in most ways. The main difference is how you connect to a NexLog recorder. 

MediaWorks Plus connects directly to the recorder, because it is a web page 

running in a browser pointed at the recorder. 

MediaAgent needs to be told where the recorder is. 

Figure 114. MediaAgent Login Prompt 

 

When you launch MediaAgent for the first time, you will be greeted by a Login 

prompt. This window allows you to log in by providing the Recorder IP address 

or domain name as well as the User name and Password. You can save these 
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values using the Save button and then later Load any saved credentials from the 

list on the left. 

You can also choose to use any of the three options: 

 Use Domain Single Sign On; If your recorder is configured with 

Enhanced Active Directory and Single Sign On is enabled, select this 

option to log in as the currently logged in Windows User. Note that the 

Recorder field must be a Fully Qualified Domain Name (e.g. 

ExampleRecorder.ExamplePlace.Local) not an IP address for Single Sign 

On to work. 

 Use SSL: This will connect to the recorder using https:// rather than 

http://. 

 Auto Login on Startup: In the case that you always want to log in to the 

same recorder, you can select this and save the session. Then in the 

future when launching MediaAgent, it will automatically log in to this 

recorder with these credentials. You can, of course, then logout and log 

in to a different recorder at any time. 

Limitations 

 Screen Playback is not supported. 

 


